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Safety information 

General 
The Waters® Micromass® MALDI Q-Tof Premier™ Mass Spectrometer is 
designed solely for use as a mass spectrometer; any attempt to use it for any 
other purpose is liable to damage the instrument and will invalidate its 
warranty.

The Waters Micromass MALDI Q-Tof Premier Mass Spectrometer conforms to 
European standard EN61010-1:2001, Safety requirements for electrical 
equipment for measurement, control, and laboratory use - Part 1: General 
requirements.

The instrument has been designed and tested in accordance with recognized 
safety standards. If the instrument is used in a manner not specified by the 
manufacturer, the protection provided by the instrument may be impaired.

Whenever the safety protection of the instrument has been compromised, 
disconnect the instrument from all power sources and secure the instrument 
against unintended operation.

The instrument must be installed in such a manner that the user can easily 
access and isolate the power source from the instrument.

Laser radiation hazard

The MALDI Q-Tof Premier uses a nitrogen laser, producing a concentrated 
beam of invisible UV radiation. The instrument is a Class 1 Laser product, as 
indicated by the following label on the top the instrument. 

Warning: The use of controls or adjustments or performance of 
procedures other than those specified herein may result in hazardous 
radiation exposure.
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If the operating procedures are followed as described in this manual, the laser 
beam will be contained within the instrument, and there will be no risk of 
exposure to laser radiation.

The MALDI Q-Tof Premier must be operated only with all exterior panels 
fitted. If any panels are removed and the laser safety interlocks are defeated 
there is a risk of exposure to invisible radiation exceeding Class 1.

The laser safety cover must only be opened by Waters service personnel 
qualified to service this instrument. When this cover is open and the 
interlocks are defeated, the instrument is a Class 3B laser hazard, indicated 
by the following warning label, fixed on the panel.
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Output specification of enclosed laser

High voltage hazard
The MALDI Q-Tof Premier produces high voltages, presenting risk of electric 
shock if the instrument is operated without the exterior panels fitted. 

The MALDI Q-Tof Premier must only be installed or relocated by qualified 
Waters field service engineers. 

Biological hazard
When you analyze physiological fluids, take all necessary precautions, and 
treat all specimens as potentially infectious. Precautions are outlined in “CDC 
Guidelines on Specimen Handling”, CDC – NIH Manual, 1984.

Suitable protection against biohazards must be taken during maintenance 
procedures and cleaning, as parts of the instrument are exposed to potentially 
infectious samples.

Chemical hazard
Good Laboratory Practice should be followed when you are using potentially 
toxic, caustic, or flammable solvents and analytes.

Pinch Point hazard
The MALDI Q-Tof Premier has moveable parts that may constitute a pinch 
point. When the MALDI source is moving keep away from the regions that are 
marked with yellow and gray labels.

Wavelength 337.1 nm

Average Power 3 mW @ 10 Hz

Repetition Rate up to 20 Hz

Pulse Width 4 ns

Pulse Energy 300 µJ @ 10Hz

Peak Power 75 kW

Beam Divergence, Full 
Angle

0.5 mrad typical
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Safety symbols
Warnings in this Operator's Guide, or on the instrument, must be observed 
during all phases of service, repair, installation and operation of the 
instrument. Failure to comply with these precautions violates the safety 
standards of the design and intended use of the instrument. Waters 
Corporation assumes no liability for the user's failure to comply with these 
requirements.

The following safety symbols may be used in the Operator's Guide, or on the 
instrument. A Warning is an instruction that draws the user's attention to the 
risk of injury or death; a Caution is an instruction that draws attention to the 
risk of damage to the instrument.

Warning:  This is a general warning symbol, indicating that there is a 
potential health or safety hazard; the user should refer to this 
Operator’s Guide for instructions.

Warning: This symbol indicates that hazardous voltages may be 
present

Warning: This symbol indicates that hot surfaces may be present.

Warning: This symbol indicates that there is danger from corrosive 
substances.

Warning: This symbol indicates that there is danger from toxic 
substances.

Warning: This symbol indicates danger of contamination by a biological 
agent that constitutes a threat to humans.

Warning: This symbol indicates that there is danger from flammable 
substances.

Warning: This symbol indicates that there is danger from laser 
radiation.

Warning: This symbol indicates that there is danger from moving 
machinery.
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MALDI Q-Tof Premier Spectrometer Information

Intended Use
The Waters Micromass MALDI Q-Tof Premier Mass Spectrometer can be used 
as a research tool to deliver authenticated exact mass in both MS and MS-MS 
mode. It is not for use in diagnostic procedures.

Calibration
Follow acceptable methods of calibration with pure standards to calibrate 
methods. Use a minimum of five reference standards to generate a standard 
curve. The concentration range should cover the entire range of quality control 
samples, typical specimens, and atypical specimens.

Quality Control
Routinely run three quality-control samples. Quality control samples should 
represent subnormal, normal, and above-normal levels of a compound. Ensure 
that quality-control sample results are within an acceptable range, and 
evaluate precision from day to day and run to run. Data collected when 
quality-control samples are out of range may not be valid. Do not report this 
data until you ensure that system performance is acceptable.
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Overview

The MALDI Q-Tof Premier provides an efficient switch between API and 
MALDI modes to deliver the degree of flexibility required in today’s research 
environment. By simply removing the API source, the MALDI source unit is 
transferred via a motorized stage to the source region, and is fixed in position. 

MALDI Q-Tof Premier:

MALDI source
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Installing the MALDI source

Before installing the MALDI source the instrument needs to be vented and 
the standard API or NanoLockSpray source housing has to be removed. These 
procedures are described in detail in the Q-Tof Premier Operator’s Guide.

To prepare for installation:

1. Click Vacuum > Vent to vent the instrument.

2. Remove the ESI probe, source housing, source drain block and ion block. 

Important: Check that the 3 O-rings on the PEEK block remain in place.

To install the MALDI source:

1. Remove the top cover of the MALDI unit. This will reveal a repository of 
the components required to fit the source.

Warning: Risk of pinch point injury while the assembly is being moved 
into place. Take care to keep fingers away from the moving assembly.

Warning: The ESI probe and source are liable to be hot. To avoid burns 
take care when removing the source housing and ion block.
Installing the MALDI source 1-3



2. Fit the adaptor plate and tighten the three 5-mm captive screws with 
the appropriate allen key. Ensure that it is square and tight.

Tip: On the back, ensure that the O-ring is fitted evenly in the groove.

3. Locate the Aperture 0 plate on the two pillars and tighten the two 6-mm 
screws with the appropriate allen key.

Tip: Do not fit the washers used with the ESI ion block. Fitting these 
will cause a vacuum leak.

Caution: Take care not to over-tighten the screws.

4. Release the catch on the source (by pulling towards you) and gently 
withdraw the assembly until it locks into position.

ESI ion block

Raise and lower 
buttons

PEEK block

Aperture 0 plate Adaptor plate
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5. Press the Raise button and hold it until the MALDI source rises to its 
required position.

Important: There is an audible indication that the source is moving.

6. With the cam locks raised, pull back the catch and advance the source 
onto the locating pillars.

7. Secure with the cam locks.

Important: Ensure that the gap, between the source and instrument, is 
parallel.

Catch
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8. Plug MALDI cable into the MALDI socket on the front panel, and the 
Heater/Interlock cable into the DESOLVATION socket.

9. Blank off the nebuliser gas. 

10. Select Vacuum > Pump to pump down the instrument. It should be 
possible to switch the instrument into Operate after approximately one 
hour.

11. Recondition the detector.

Result: The instrument is now ready to use.

To remove the MALDI source:

1. Unload the MALDI sample plate and select Vacuum > Vent.

2. When the instrument has vented, remove the cables and fit them into 
their parking positions.

3. Release the cams and pull the source backwards until it locks in its ‘out’ 
position.

4. Press the Lower button and hold until the source is at its predefined low 
position.

5. Release the catch and push forward.

Cam locks down

MALDI cableHeater / Interlock cable

Ensure gap is 
parallel
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6. Remove the Adaptor plate and Aperture 0 plate and store them, with the 
allen keys, in the component repository.

Result: The instrument is now ready for the fitting of other sources.

Troubleshooting:

You a cannot switch the instrument into Operate unless ‘Vacuum OK’ is 
displayed in the Status bar.

If after requesting Operate the vacuum status is ‘Pumped - Tof vacuum out of 
range’, the instrument vacuum has not reached a suitable operating pressure. 
This may be caused by an extended period between venting and pumping 
down, while changing sources. 

If the vacuum status has not reached Pumped then this may be due to vacuum 
leaks. If there is clearly a gap or an audible hiss then the source is not fitted 
correctly. 

Either of these can caused by:

• The source not being parallel with the instrument.

• Fitting the washers from the ESI ion block.

• The Aperture 0 plate. Ensure this fitted tightly to the ion block.

• O-rings having fallen out or not being seated correctly. Vent the 
instrument and check the O-rings before refitting the source. 

Check that the gap, between the source and instrument, is parallel.

• Inappropropriate height of the MALDI Source. If this is the case, contact 
Waters (see Contacting Waters on page 4-6).
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The Tune window

After the MALDI source is installed, the MALDI specific parameters can be 
viewed. 

To view the MALDI Tune window:

On the Tune window select Source > MALDI.

Note: The Source page is not automatically selected, the Heater/Interlock 
cable must be connected to allow you to view the MALDI source page. 

Tune window:

In addition to the tasks that are described in the Q-Tof Premier Operator’s 
Guide you can:

• Load sample plates and select sample wells.

• Display a camera image of the sample.

• Fire the laser and optimize the spectrum.

• Save and recall settings for use with different samples.
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• Set parameters on the MALDI source page.

Sample plates

Operating the plate carrier
Important: It is not necessary to select Standby mode when loading and 
unloading plates.

To load plates:

1. Press the Open button.

Plate carrier:

2. Take the sample plate by the sides, aligning it so the corner indent is to 
the left, and place it level with the plate carrier.

3. Close the plate carrier lid.

4. From the Tune window click .

Result: The system pumps the plate carrier (this will take 
approximately 3 minutes) and the sample plate is transported into the 
source.

Open button

Plate carrier lid

Plate carrier with plate
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5. Enter the sample well number in the sample box.

The selected sample well is aligned with the laser beam.

After the sample plate is loaded, the Unload button is highlighted blue 
to show that Unload is available. 

Neither button is highlighted when the instrument is acquiring data.

To unload a plate:

1. From the Tune window click .

2. When the carrier has stopped moving open the plate carrier lid and 
remove the plate, taking care not to touch the surface.

Plate carrier errors

The current status of the plate carrier is displayed in the Tune window Status 
bar. Error messages are displayed in the Plate Carrier Status Message dialog 
box. If you connect the Heater/Interlock cable when a plate is already loaded, 
it is normal to receive the Status Message as shown.

This message box indicates that the sample plate control is restarting. If the 
plate carrier is in the Unload position this message will not appear.

Other errors give possible solutions in the dialog box and are indicated by the 
status of the Load/Unload buttons (see Plate carrier errors on page 4-4).
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Sample plate formats
The MALDI Q-Tof Premier comes with several plate formats already defined. 
These are the standard 96 well MALDI sample plate (shown below), 384 well, 
MassPrep™, DIOS and BigSpot.

Standard 96 well sample plate:

Viewing and setting plate formats

From the Tune window click Maldi > Sample Plate Definition to open the 
Sample Plate Definition dialog box.

Load/Unload button states:

State Meaning
Blue Normal operation - Load/Unload

Red Recoverable error. The plate is out of position. 
The error is cleared by clicking the buttons and the 
plate reindexes. If it does not recover contact Waters.

Both disabled This can be one of three things:
• Acquiring data
• Vented error
• Plate carrier error (see page 4-4)

Sample Well A1

LockMass well for 
A1, A2, B1, B2
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Sample Plate Definition dialog box:

To select a predefined plate:

1. Select from the drop down list in Plate Type.

2. Click OK.

To create a user defined plate:

1. Click New.

2. Enter relevant parameters for the plate type you are using.

3. Select the Index Type drop down list to select Numerical or Alpha 
Numeric addressing of the sample wells.

4. Select Use Lock Mass Wells for the system to recognize the near point 
correction wells used to improve and validate external mass 
measurement accuracy.

5. Click Save As and save with an appropriate name.
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To open a user defined plate definition:

1. Click Open.

2. From the Open dialog box select the required *.mtp file.

3. Confirm the settings are correct, and click OK.

Sample log sheet

A sample log sheet, ‘MALDI_SAMPLE_LOG.pdf’, is included with your 
MassLynx installation in the MassLynx folder.

Sample log sheet:

With Adobe Acrobat Reader installed on your PC, you can print log sheets and 
record sample details.

E1 E2 E3 E4 E5 E6 E7 E8 E9 E10 E11 E12

F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12

A2 A3 A4 A5 A6 A7 A8 A9 A10 A11 A12

B1 B2 B3 B4 B5 B6 B7 B8 B9 B10 B11 B12

A1

G1 G2 G3 G4 G5 G6 G7 G8 G9 G10 G11 G12

H1 H2 H3 H4 H5 H6 H7 H8 H9 H10 H11 H12

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 C11 C12

D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 D11 D12

MALDI 96 WELL SAMPLE LOG
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Obtaining an ion beam

In this section you will learn how to control the laser so that the peak display 
displays an ion beam.

Controlling the camera
The camera is used to view the sample plate in position. The camera image of 
the selected sample well has crosshairs indicating the firing point. The point 
at which the laser has fired on the sample can be seen as a bare patch where 
the sample has been consumed.

To operate the camera:

1. Click  to open the camera.

2. Click in the status bar to toggle between Live and Static images.

In Static Image crosshairs can be moved around by clicking in the 
image. In Live Image the crosshairs cannot be moved.

Aligning the camera image
The laser may fire but may not be perfectly in line with the crosshairs. This 
can be corrected from the Camera window.
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To align the laser position to the camera image:

1. Fire the laser, at a prepared sample well, without moving its position 
until enough material has been removed from the sample plate to allow 
you to see where the laser is actually firing.

2. Click the status bar to toggle to Static Image.

3. Click on the camera image at the position of the laser firing mark. This 
moves the camera crosshairs to position selected with the mouse.

4. When the laser and crosshair positions are satisfactorily aligned with 
each other, click in the status bar to toggle back to a Live Image.

The camera software stores the crosshair position.

Aligning the laser and the sample well:

After the camera crosshairs have been set to indicate the laser fire position 
the center of the sample well may not be aligned with the camera crosshairs.

The sample well position relative to the camera image is set from the Tune 
window.

To realign the sample well position:

1. Click Maldi > Source Settings > Password and type ‘access’.

2. In the Source Settings dialog box click Sample Plate and select Nudge 
Using Crosshairs.

Result: The plate moves to sample well A1.

3. Adjust the sample plate crosshairs until the center of the sample well is 
aligned with the camera crosshairs. 

4. Click  to store the current alignment.

5. Repeat steps 3 and 4 until the sample well center and the laser firing 
mark are satisfactorily aligned.

6. Click  to accept and use the current alignment.

Result: The plate reindexes and moves to sample A1 using the latest 
alignment settings.
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Controlling the sample plate
During an acquisition the sample plate is controlled either using a crosshair 
pointer or by following a predefined pattern.

Acquisitions from the Sample List only use pattern control.

Pattern editor

A pattern is constructed from a series of nodes (up to a maximum of 100). 
These nodes define a series of points between which the plate carrier moves. 
When the end of the pattern is reached the movement stops. If an acquisition 
is being run from the Sample List and the end of pattern is reached the 
acquisition also stops. 

Each pattern is scaled to fit the sample wells, so that there are same number 
of nodes in a 2.5 mm well as there are in a 2 mm well.

There are 13 predefined patterns, either spiral or straight line, that can be 
loaded from the Pattern Editor (see Figure titled “Spiral pattern in Pattern 
Editor:” on page 1-17). Further patterns can also be defined in the Pattern 
Editor if required. The *.ptn files are comma delimited text files and can be 
opened and modified in any spreadsheet application.
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Spiral pattern in Pattern Editor:

Starting an acquisition
An acquisition can be performed in one of three ways:

• Obtaining an ion beam displays the data on the Tune window peak 
display, but does not save any data to disk.

• Acquiring data from the Tune window creates a data file and saves data 
to disk.

• Acquiring data from the Sample List allows you to create multiple data 
files in a batch format.

Initial instrument settings

Ensure the following items have been set:

• From the RF Settings dialog box, ensure the values and quadrupole 
options are set as shown below.
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• On the Instrument page, set the detector voltage 100 V higher than for 
ESI (this is a typical example, actual voltages may vary. Contact Waters 
for further information).

• The Collision and API gasses are on.

• The cooling gas is set to 10.

• The mass range in the Tuning Settings dialog box is appropriate to your 
sample.

• The laser firing rate is set to maximum.

• The ion mode and polarity appropriate to your sample.

RF Settings dialog box:

To obtain an ion beam:

1. Click  to switch the camera on and view the sample plate.

2. Select a sample well containing your sample. 

3. Click  from the Tune window tool bar.
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Result: The MALDI control window opens. The appearance of the 
window will depend on your settings in the Source Settings dialog box.

4. Click , from the MALDI control window, to fire the laser. 

As appropriate use either the crosshairs or the pattern to move within 
the sample well.

5. The data produced by the instrument is shown on the Tune window peak 
display. 

6. Click  in the MALDI control window to finish. 
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MALDI control windows:

Acquiring data from the Tune window

Before acquiring data from the Tune window it is necessary to determine:

• What the data file name and comments will be.

Crosshairs selected Pattern file selected

Expanded dialog

Click to go to a 
LockMass well

Steps through the 
pattern at the defined 
rate

Toggles laser on 
and off

Expand or contract 
window
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• What type of acquisition will be performed; MS or MS/MS.

• What overall duration and scan times will be used.

• What mass range and, if an MS/MS acquisition is selected, what 
precursor mass is required.

• What Sample Plate Control type will be used.

To start an acquisition:

1. Click  to switch the camera on and view the sample plate.

2. Select a sample well containing your sample.

3. Click  from the Tune window tool bar.

Result: The Start Acquisition dialog box opens. The acquisition type and 
settings are selected from this window.

Start Acquisition dialog box:

4. Enter settings appropriate to your acquisition.
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5. Click Start to begin acquiring data.

Result: The MALDI control window opens. The appearance of the 
window will depend on your settings in the Sample Plate Control section 
of the Start Acquisition dialog box.

6. Click , from the MALDI control window, to fire the laser. As 
appropriate, use either the crosshairs or the pattern to move within the 
sample well.

The data can be observed in Spectrum or Chromatogram, and the peak 
display.

7. Based on the quality of the data being acquired, adjust the laser energy, 
collision energy (for MSMS) and pattern step rate until a satisfactory 
combination of peak intensity and sample consumption is achieved. 

8. Click  in the MALDI control window to finish acquiring.

Tip: Acquire data from the Tune window and arrange the MALDI 
control dialog so that you can also see the Chromatogram and Spectrum 
windows. View the chromatogram and spectrum in real-time as you fire 
the laser.

To acquire data from the Sample List:

Before acquiring data from the Sample List it is necessary to:

• Select a MALDI specific sample list format.

• Complete a sample list entry with the following information:

• Filename

• Method (see Method Editor on page 3-2)

• Sample Well

• Optionally the following information can be specified:

• File comment text

• Instrument parameter file

To start a sample list acquisition:

1. Create a sample list with the information as described above.

2. Save the sample list.

3. Click  from the MassLynx Toolbar.
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Result: The Sample List begins acquiring; creating the data filename 
requested, using the selected method and sample well.
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2 Calibration

Calibration for MALDI is very similar as for that described for ESI in 
the Q-Tof Premier Operator’s Guide. Create calibrations that encompass 
the mass range that the instrument will acquire over. Acquiring beyond 
the calibrated range will limit the mass accuracy returned by the 
instrument.

Contents:

Topic Page
Processing MALDI data 2-2

Calibrating 2-4

Using LockMass for Greater Mass Accuracy 2-8
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Processing MALDI data

Processing MALDI data involves combining, smoothing, background 
subtraction and centering spectra. Where this data is used for creating a 
calibration the processed spectrum is also saved into the file history.

To process data:

1. Right-click and drag beneath the chromatogram, to select and combine 
spectra. 

2. Select the spectrum as the active window by clicking anywhere within it.

3. Select Process > Smooth.

4. In the Smooth dialog box, enter the settings shown in the following table 
and click OK.

5. Select Process > Subtract.

6. In the Background Subtract dialog box, enter the settings shown in the 
following table and click OK.

7. Select Process > Center.

Smooth Settings

Parameter V and W mode
Smooth window 
(channels) 

3

Number of smooths 2 

Smoothing method Savitzky Golay 

Subtract Settings

Parameter V and W mode
Polynomial order 15

Below curve (%) 10 

Tolerance 0.01 
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8. In the Spectrum Center dialog box, enter the settings shown below and 
click OK.

9. From the Spectrum window, select File > Save Spectrum to open the 
Spectrum save dialog box, and click OK.

Note: Saving processed spectra into the file History, allows this 
processed information to be recalled directly without repeating the 
individual steps.

Center Settings

Parameter V mode W mode
Min peak width at 
half height (channels)

4 6

Centroid top (%) 80 80
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Calibrating

To return mass data of consistent accuracy, calibrate the MALDI Q-Tof 
Premier regularly against reference compounds appropriate to your project: 

• Daily, or

• Before long automated data acquisitions, or

• For each sample plate. 

Calibrations created from MS acquisitions are valid for MS, MSMS and 
Survey experiments.

Using the Calibration window
From the Tune window, select Calibration > Calibrate TOF to open the 
Calibration dialog box. 

Calibration dialog box:
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With this box you can: 

• Choose an appropriate reference file from a drop-down list. 

• See when the instrument was last calibrated.

• See the instrument settings from that calibration.

• Save your calibration as a file and recall previous calibrations.

Calibrating from previously processed data
The data acquired, as shown in the previous section or from the Sample List, 
can be used for calibrating the instrument. In addition, a calibration reference 
file relevant to the data is required.

In the following section, the example file MQT_Example_01.raw is used to 
illustrate the calibration steps.

To calibrate form previously processed data:

Tip: Waters recommends you calibrate using PEG 600, 1000, 1500, and 2000, 
and that you use the reference file Com_PEG_Na_MS, which is appropriate 
for this sample.

1. From the Tune window, select Calibration > Calibrate TOF to open the 
Calibration window.

2. Select the relevant reference file for your calibrant.

3. Select Calibrate > Create Calibration. 

4. From the Select file for Calibration dialog box, navigate to your raw data 
file.
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5. Click History to display the History Selector dialog box 

The box shows the processing steps previously applied to the raw data 
spectrum. 

6. Click the saved version (highlighted black).

Note: Calibration can only be performed on centered data.

7. Click OK.

Result: MassLynx performs the calibration calculations and displays the 
resulting calibration graph. 
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8. Click File > Save As to save the calibration to accept the calibration. 
Enter a file name appropriate to your project.

Caution: Always save the calibration with a new name. Do not overwrite 
Uncal.cal.

A polynomial order value of five should be used. If the acquisition mass 
range is beyond the calibration mass range, create a new calibration 
using polynomial order one; to ensure the mass measurement accuracy 
is maintained in the extrapolated region.

Tip: It is good practice when saving a calibration to use the date as the 
filename.

If the calibration is not acceptable, outliers can be removed and peaks 
reassigned see the Q-Tof Premier Operator’s Guide for further details.
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Using LockMass for Greater Mass Accuracy

You can improve the mass measurement accuracy of acquired data by 
applying a uniform mass adjustment taken from a simultaneously acquired 
reference peak. This allows you to compensate for small, local variations in 
the calibration arising from effects such as drift in laboratory temperature, 
and is referred to as LockMass.

MassLynx extracts a mass from centered data, compares it to the exact mass 
that you specify (the LockMass) and applies the adjustment necessary to align 
these two numbers. This adjustment is automatically applied to all the 
spectra in a data file, but only to the function that the LockMass is generated 
from.

• Internal LockMass correction means that the mass of one peak within 
the sample data is used to correct the calibration. 

• External LockMass correction means that one peak from within the data 
acquired from a LockMass sample well is used to correct the calibration.

• An acquisition may contain data which can be used for both internal and 
external correction, however only one type is used at any one time.

• Where LockMass is acquired from the Sample List it is of the External 
type and is saved in a separate function to the sample data within the 
MassLynx raw file.

• Where LockMass is acquired from the Tune window it is of the External 
type and is saved in the same function as the sample data within the 
MassLynx raw file.

• For external LockMass use a sample of a known mass at a concentration 
that produces approximately 100 counts/second. Stronger concentrations 
produce distorted mass measurement; weaker concentrations require 
long acquisition times to produce data that does not contain statistical 
errors.

• Acquisitions from the LockMass sample well should be short in duration 
to maximize the acquisition time on the principle sample. A total 
intensity of approximately 1000 counts is sufficient.

• When acquiring from a sample list if the end of pattern on the LockMass 
sample well is reached the acquisition stops. With the standard sample 
plate configuration one LockMass sample well is shared between four 
sample wells.
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Creating LockMass Correction
To create a LockMass correction the LockMass data must be processed to 
centered masses and the specific LockMass peak extracted.

Note: The figures in this section refer to the example file 
MQT_Example_01.raw (PEG MS - Using an internal LockMass).

To create a LockMass correction:

1. Combine together the spectra that contain the LockMass peaks.

2. Smooth, subtract and center this spectrum as described in Processing 
MALDI data on page 2-2.

3. Select Tools > Lockmass to open the Lock Mass dialog box.

4. In the box Lock Mass (Da/e), enter the correct mass for your Lock Mass 
compound. 

Lock Mass dialog box:

5. In the box Window (Da/e), enter a value to enable MassLynx to identify 
the peak associated with this mass.

6. Click OK to display the AutoCalibrate window.

Result: The Gain value displayed in the AutoCalibrate window is the 
multiplier correction that will be applied to all the spectra in the data 
file for the selected function.
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AutoCalibrate dialog box:

A gain of   1.0 applies no correction to the data.

A gain of >1.0 e.g. 1.000067 increases the mass values.

A gain of <1.0 e.g. 0.999933 decreases the mass values.

7. To accept the LockMass correction, click Yes.

Applying LockMass Correction

Internal LockMass

If using an internal LockMass the steps above have applied the LockMass 
gain correction to the sample data as well as to the LockMass data. This is 
because the sample and LockMass data are saved in the same function.

External LockMass from the Tune window

If using an external LockMass acquired from the Tune window the steps 
above have applied the LockMass gain correction to the sample data as well as 
to the LockMass data. This is because the sample and LockMass data are 
saved in the same function.

External LockMass from the Sample List

If using an external LockMass acquired from the Sample List the steps above 
have not applied the LockMass correction to the sample data. This is because 
the sample and LockMass data are saved in separate functions. 

To apply the LockMass gain correction to the sample data copy the gain 
correction value generated above into each data function using the clipboard.

The figures in this section refer to the example file MQT_Example_05.raw 
(Enolase MS - Using an external LockMass) and assumes that the LockMass 
correction has already been created.
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To apply a LockMass correction:

1. Display a spectrum from all the functions within the data file to which 
the gain value will be applied.

2. Select the LockMass data as the active function as indicated by the 
marker in the spectrum display (see below).

 

3. Select Spectrum > Tools > Modify Calibration 

4. In the Gain field, highlight the entire number by double clicking within 
the field.

5. Either right-click or press Ctrl C to copy this selected value into the 
clipboard.

6. Close the Modify Calibration window.

7. Select another function.

8. Paste the gain value into the Gain field as in steps 3 and 4.

9. Repeat steps 7 and 8 for all functions as appropriate.
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Result: The gain correction created from the LockMass data has been copied 
to the other data functions. The other data functions are now LockMass 
corrected.

Notes: 
• The gain correction may also be typed into the Gain field.

• Gain values are stored with the data file and are preserved when the 
data file is closed.
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3 MALDI Acquisition

The principles of acquisition for MALDI are similar to those described 
for API in the Q-Tof Premier Operator’s Guide and many of the 
parameters are described there.

Contents:

Topic Page
Method Editor 3-2

Peak detection 3-6

Software Setup 3-11

MALDI Survey method 3-15

EDC for MALDI methods 3-17

Auxiliary file output 3-18
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Method Editor

In addition to the 6 acquisition types described in the Q-Tof Premier 
Operator's Guide, the MALDI Q-Tof Premier has a further three:

• MALDI MS

• MALDI MSMS

• MALDI Survey

Each type has several pages of parameters. The Scan Conditions page and the 
LockMass page are common to all three types of acquisition.

Sample List Formats
To use the full functionality of the MALDI methods the MALDI specific 
sample list format should be selected. This displays the column configuration 
applicable to the MALDI MS, MSMS and Survey methods. 

To change a sample list format:

1. MassLynx Sample List > Samples > Format > Load

2. Select MALDI Q-Tof Premier.

This is applicable to the MALDI source only.

Scan Conditions page
The Scan Conditions page is used for setting the instrument conditions for the 
acquisition.

Scan Rate frame

As the samples analyzed by MALDI do not change within one sample well it is 
not necessary to scan at a high rate.
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The automatic scan rate is 5 seconds with an Inter-scan delay of 0.02 seconds. 
To select values different from this select Manual Scan Rate.

Instrument Mode frame

This frame is used to set the ion mode, V or W mode, and whether EDC is 
used. If you select Automatic the acquisition will be in V positive mode with no 
EDC.

Source Settings frame
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This frame allows you to set the conditions for the laser. Either the settings 
from the Tune window are used or a user defined pattern file, Step Rate, 
Firing Rate and Laser Energy can be entered.

When a sample list acquisition is taking place the motion starts at the 
beginning of the pattern and moves at a constant speed towards the end. The 
history of the plate movement is used during the experiment. So if the sample 
spot has been used before, then the plate begins moving from the last used 
point.

Important: Only one pattern history is held in MassLynx. The pattern 
specified has to be the same as that last used in the Tune window so the 
pattern history is consistent.

Tip: The Step and Firing rates should be set to suit the samples. Waters 
recommends that various settings are tried using manual acquisitions.
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LockMass page

When ‘Acquire from the LockMass sample well’ is checked, the sample plate 
moves to the LockMass sample well. Data is acquired for the time defined in 
the set-up as shown above.

The LockMass data is acquired over the same mass range as the MS scan. In 
addition the LockMass uses the same scan conditions and pattern as the MS 
acquisition. The data from the LockMass acquisition is always written into 
the last function in the data file. 
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Peak detection

In addition to acquiring data for a fixed amount of time, the MALDI 
Q-Tof Premier offers the option of acquiring until a user-defined quality 
threshold is reached. Within the MALDI method editor this is referred to as 
peak detection.

MS Scan and MS Survey

As each spectrum is acquired, it is saved to disk and then combined with all 
the previous scans into a ‘rolling-average’. (This average is actually a sum as 
no division takes place.) This rolling-average is continued until there is a peak 
in this combined spectrum with an intensity greater than a user defined 
threshold. In this way if two samples gave different intensity MS scans, where 
the first was strong and the second weak, the MS spectrum would be acquired 
for different lengths of time, but would contain peaks of the same intensity. In 
this way the data is normalized for the data quality rather than duration.

Although every spectrum is recorded, the rolling-average is only started once 
the chromatogram TIC has risen above a user defined value.

In a MALDI Survey scan only one MS scan is performed. Consequently all the 
information used to extract peak information, which is used to create the 
MSMS peak list, must be generated from this one combined spectrum. By 
combining scans the signal to noise can be enhanced so that weak peaks as 
well as the strong peaks are recorded.

Within the mass range of the MS scan, a Peak Monitor Window is defined. 
Only peaks which fall within this window are considered when the 
rolling-average is being interrogated to determine if there is, or is not, a peak 
present. If the Peak Monitor Window is set to include all the mass range then 
the MS scan is stopped when the largest peak in the spectrum reaches the 
threshold.

If the mass range of the scan were extended down to low mass the matrix ions 
would be recorded, but they can be ‘screened out’ so that their intensities, 
although recorded, do not contribute to the conclusion of the MS acquisition. 
In this way their relative intensities may be used as a rough guide to the 
intensity of the signals of interest. Alternatively, if clusters of interference 
peaks are known to be present, then the peak monitor window could be set to 
exclude where these lie - remembering that the (accurate mass) exclude list is 
only applied after the MS scan is complete. Note that there is only one peak 
monitor window defined within each experiment set-up.
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Peak monitor window

In the example of a completed MS spectrum, a Peak Monitor Window has been 
defined which extends from ~45% to ~100% of the mass range. Although there 
are intense peaks, such as A and those at the low mass (left hand) end of the 
spectrum, these are not considered when the spectrum is interrogated for 
‘peaks present’. Instead the peak C has exceeded the threshold and this, 
because it falls within the Peak Monitor Window, has triggered the end of the 
MS scan. The rolling-average spectrum is not directly visible to the user, it is a 
virtual spectrum that exists only in the instrument control system.

If the MS scan is part of a Survey experiment then, once the MS scan has 
completed, the data is processed to determine a list of precursor masses that 
MSMS will be performed on. It is the rolling-average spectrum that is 
considered in the Peak Detection phase. If, however, the MS scan is part of an 
MS experiment, the acquisition completes at this point.

The combined spectrum is peak detected (converted to centroid data) and a 
Peak Switch Window applied to the result. Any masses outside the Peak 
Switch Window will not be considered for further processing. Typically the 
Peak Switch Window will cover a larger portion of the mass range than the 
Peak Monitor Window. If the peak switch window is set to be the same as the 
mass range then every peak will be considered. Within this window a Peak 
Switch Threshold is defined. Once the data has been processed, only peaks 
above this threshold will be considered as MSMS precursor masses. 

The peak-detected spectrum is submitted to a de-isotoping routine. This 
produces a list of mono-isotopic masses that correspond to the peaks present 
in the combined MS spectrum. This list is then filtered to remove peaks that 
have intensities below the peak switch threshold.

Peaks not considered

Peak monitor window

Mass
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Peak switch window

Peak switch threshold
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This reduced list is then ranked in intensity order (where the most intense 
peaks are at the beginning) and, finally, it is compared to the contents of the 
Include and Exclude settings (see Q-Tof Premier Operator’s Guide). This final 
list then provides the precursor mass information from which automated 
MSMS will be performed. 

The Survey method will then run in MSMS mode. Each mass is acquired in 
turn, rather than simultaneously. 

The experiment continues until either the list is complete or the end of the 
(MALDI sample plate) pattern is reached. The sequence described above is 
carried out automatically. The results of the individual steps are not available 
to the user. In the example shown, the combined MS scan is first filtered by 
the Peak Switch Window which, in this case, rejects all the low mass peaks. 
This reduced spectrum is de-isotoped and then all the peaks that fall below 
the Peak Switch Threshold are rejected, leaving four candidates for MSMS. 
These are then ranked in intensity order summarized in the following table.

MSMS Acquisition

The MSMS acquisitions follow a similar method to that of the MS i.e. a 
spectrum is recorded; that spectrum is combined with all the previous spectra; 
the combined spectrum is then interrogated for a peak intensity; if the 
spectrum is below the threshold the acquisition is continued, if the spectrum 
is above the threshold then the acquisition completes. If there are more MSMS 
masses available then the cycle is repeated with the next mass until the end of 
the list is reached.

In a Survey acquisition the mass range of the MSMS acquisition is set 
independently from that of the MS acquisition. A separate start mass is 
defined and the end mass is set dynamically as an offset above the MSMS 
precursor mass. For example, if an offset of 75 were used (and the start mass 
was 50), then, if multiple set masses were defined of it peaks were detected at 

Final MSMS order:

MSMS order Peak
First A

Second C

Third D

Fourth B
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1000 and 1500 amu, the first acquisition would be from 50 to 1075 and the 
second from 50 to 1575.

In order to produce fragmentation, the collision energy needs to be defined. 
This is either done in the same way as it is for the single MSMS scan or by 
using Collision Energy Profiling. This Collision Energy Profile is a look-up 
table, that the user can create, which defines the relationship between 
collision energies and mass. When the acquisition begins, the collision energy 
is taken from this table and used until that acquisition is completed. The 
example collision energy profile, 
C:\Masslynx\QTofPremier\MQT_CE_Profile.txt, is included as part of the 
software installation.

As each spectrum is acquired, it is combined into a rolling-average (as is done 
with the MS scan) and this combined spectrum is monitored for ‘peaks 
present’. To this rolling-average a Monitor Window is applied. Only peaks that 
fall within this window and are above a user defined intensity threshold will 
be considered. This Monitor Window is defined from the Start Mass of the 
MSMS mass range up to a (user defined) percentage below the precursor 
mass.

e.g. If the precursor mass was detected as 1000 amu (the Start Mass set to 50), 
and the Monitor Window was defined as 10% below the precursor mass, then 
only when there was a peak in the mass range 50 to 900 amu - which was 
above a threshold - would this MSMS acquisition stop. This is shown in the 
following figure (Figure titled “MSMS Monitor window:” on page 3-11) where 
the peak at y1 has triggered the end of the acquisition.

This Monitor Window can then be set so that the intensity of the precursor 
mass is not considered when the spectrum is interrogated. In this way only 
fragment peaks contribute to the intensity. For example, where one precursor 
is intense and the second is weak, (then by only considering the fragment 
ions), the two acquisitions will run for different lengths of time but will have 
the same fragment intensity when they have finished. In this way the data is 
normalized for fragmentation quality, not for the time spent on that mass.
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MSMS Monitor window:

Software Setup

MALDI MS method
For a MALDI MS method there are three pages of parameters that need to be 
considered. The Scan Conditions page and LockMass page are described in the 
Method Editor on page 3-2. The MS page controls the conditions specific for 
the MALDI MS scan.
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Mass
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Software Setup 3-11



When performing an MS scan there are three things to consider:

• The acquisition mass range

Enter the Start Mass and End Mass to define the acquisition mass 
range.

• When to Stop Acquiring data

This can be done for a fixed time or peak detection can be used to 
determine when to stop the acquisition.

• The peak detection conditions
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These are the same as those described in Peak detection on page 3-6. 
The low and high mass define the peak monitor window.

MALDI MSMS method
For a MALDI MSMS method there are five pages of parameters that need to 
be considered. The Scan Conditions page and LockMass page are described in 
Method Editor on page 3-2. The Collision Energy page options are described in 
the Q-Tof Premier Operator’s Guide. 

The two remaining pages are:

• The MS/MS page which sets the acquisition parameters.

• The Precursor Mass page which sets the precursor masses of interest.

MS/MS page

When performing an MSMS scan there are two things to consider:

• The acquisition mass range.

Use an Automatic Mass Range or enter the Start Mass and End Mass to 
define the acquisition mass range. 

• When to stop each MSMS scan.

This can be done after a fixed amount of time or after the intensity rises 
above a certain threshold. Precursor Mass Offset described in Peak 
detection on page 3-6 relates to the “Do not consider top % of mass 
range” parameter.
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Precursor Mass page

The MS/MS Precursor Mass can be defined in the following ways:

• Single Mass - enter a single precursor mass that will be used by all the 
samples.

• Entries in Sample List - select this option if the precursor masses are 
defined individually in the Sample List. A maximum of 26 masses can be 
defined by inserting the MASS A to MASS Z fields into the Sample List. 
Enter an individual mass into each field.
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• File in Sample List - select this option if you have several precursor 
masses defined in a text file. The Sample List references this file by 
using the SPARE 1 field. A different file can be used for each entry in the 
Sample List. The field must contain the full path description to the file 
and must be less than 50 characters in length.

• List below - a precursor mass list can be built in the Mass Switch list. 
Alternatively a text file can be loaded. By adding a list of masses each 
mass can have its own; LM and HM quad resolving setting; Timeout, 
Stop Intensity; collision energy settings - that supersede the general 
settings.

MALDI Survey method

For a MALDI Survey method you need to set conditions for the MS and MSMS 
portions of the experiment. These are the same as described for the MS and 
MSMS scans. In addition three extra pages are described below:

• MS to MSMS - defines the conditions at which to switch. 

See MS to MSMS page on page 3-16 for more details.

• Include - defines a set of masses to include. 

The options for this are identical to those described in the Q-Tof Premier 
Operator’s Guide.

• Exclude- defines a set of masses to exclude.

The options for this are identical to those described in the Q-Tof Premier 
Operator’s Guide, except for Reject peaks using peptide mass sufficiency 
model. This is an extra filter that excludes mass peaks if their mass is 
outside the theoretical window for peptide masses (based on Mann, M. 
Possible Peptide Masses. Proceedings of the 43rd Conference on Mass 
Spectrometry and Allied Topics, Atlanta, GA, 21-25 May 1995, p. 639). 
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MS to MSMS page

Peaks for MS/MS

There are three options for determining how many peaks are selected for 
MSMS. Either:

• Attempt all peaks on the list by selecting ‘Do not limit the number of 
MSMS peaks selected from the MS Survey Data’.

• Enter a maximum number of peaks to consider by selecting ‘Maximum 
number of MS/MS peaks from the MS Survey data’.

• Do not acquire any MS/MS data.

You can also choose to invert the detection order. If this is the case the list 
selected for MSMS is run through backwards. The least intense peak from the 
selected list is surveyed first as opposed to the most intense.

Peak Selection from MS Survey Data

When switching from MS to MSMS, another window for peak selection is set 
- independent of that set for MS peak selection. This enables you to set a 
different mass range if required.
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EDC for MALDI methods

MS method
EDC enhances a window of masses centered on the mass specified on the Scan 
conditions page. This mass can fall anywhere within the MS acquisition mass 
range.

If LockMass is selected then the enhanced LockMass mass range is centered 
at either the same mass as the MS data or, if Correct Auxiliary files is 
selected, centered at the specified LockMass mass.

MSMS method
EDC enhances a window of masses centered on the mass specified on the Scan 
conditions page. This mass can be any value below the MSMS precursor mass.

If LockMass is selected the enhanced LockMass mass range is centered at the 
specified LockMass precursor mass.

Survey method
EDC is not available with the Survey method.

EDC calibration
As part of any EDC method the instrument is automatically configured as 
though the acquisition end mass is 4000 m/z. However, data is only recorded 
over the mass range specified within the method, which may have a lower end 
mass than 4000. To ensure mass measurement accuracy with EDC data a 
LockMass should be used as part of the acquisition method. If this is not 
practical an instrument calibration should be created from data acquired with 
an End Mass of 4000 m/z so that the acquisition conditions are matched to the 
instrument configuration.
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Auxiliary file output

The MS, MSMS and Survey methods automatically create peak list output 
files for use in applications outside of MassLynx. These Auxiliary files are 
created within the data file folder.

Each file contains a deisotoped mass-intensity pair peak list in a format 
applicable to the method from which it was produced.

MS output files
• _deisotoped.txt

• _deisotoped_sbi.txt

Consist of tab separated mass-intensity pairs. Each line also contains the 
sample well from which the data was acquired.

MSMS output files
• _precursormass_counter.pkl

• _total.pkl

Consist of PKL format mass-intensity pair list. Where _total.pkl is all the 
individual pkl files combined sequentially.

e.g. A method that acquires MSMS from 1570.6774, 1296.6853 and 2465.1989 
would produce four auxiliary files:

• _1570_1.pkl

• _1296_2.pkl

• _2465_3.pkl

Method MS peak 
list

MS peak 
list sorted 
by 
intensity

MSMS pkl 
per 
precursor 

MSMS pkl 
of all 
precursors

List of 
detected 
precursors

List of 
acquired 
precursors

MS Yes Yes No No No No

MSMS No No Yes Yes No No

Survey Yes Yes Yes Yes Yes Yes
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• _total.pkl

Survey output files 
As MS and MSMS with the addition of:

• _peaksforMSMS.txt

• _switched.txt

Where _peaksforMSMS.txt contains the peaks that fulfill the peak selection 
criteria of the methods and _switched.txt contains the peaks that MSMS was 
actually recorded for.
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4 Maintenance and 
Troubleshooting

In addition to the standard maintenance on Q-Tof Premier, described in 
the Q-Tof Premier Operator’s guide, there are some additional 
maintenance procedures required for the MALDI source.

Contents:

Topic Page
Cleaning the hexapole 4-2
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Cleaning the hexapole

The hexapole will require cleaning on a regular basis. In most cases, gently 
washing the hexapole with a wash bottle filled with propan-2-ol (IPA) will be 
sufficient. In severe cases, the whole assembly can be placed in a large beaker 
of propan-2-ol and sonicated for 30 minutes.

To vent the instrument:

1. Put the instrument in Standby.

2. Click Vacuum > Vent to vent the instrument.

To remove and clean the hexapole:

1. Disconnect the MALDI cable and the Heater/Interlock cable from the 
front panel.

2. Disconnect the Hexapole Lid cable.

3. Release the four captive screws and two captive dowell screws.

4. Gently pull out, tilt forward, and lift out of the source.

Caution: Ensure that the Hexapole Lid cable is refitted before switching 
the instrument into Operate.

Warning: The instrument components are liable to be 
contaminated with biologically hazardous and toxic materials. 
Wear rubber gloves at all times while handling the components.

st

Warning: Ensure the instrument is in Standby mode and vented 
before removing the hexapole.
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Cleaning and replacing the vacuum lock O-ring

If the sample plate carrier fails to pump the plate carrier lid within the 3 
minute system time-out period, a plate carrier error will occur.

The time out can be caused by either

• The lid failing to seat correctly on the vacuum lock o-ring

• The vacuum lock o-ring has failed or is contaminated. 

To remove and clean the O-ring:

1. Unload the sample plate and open the plate carrier lid.

2. Lift the O-ring off the spigot.

3. Clean the O-ring and its seating surface with a lint-free cloth and 
suitable solvent, such as methanol. 

4. Clean the inside surface of the lid as described in step 3. Ensure that no 
hairs or particles remain. 

Examine the integrity of the O-ring. If it is in good condition, refit it, 
seating it evenly around the spigot. If its condition is in any doubt, fit a 
new O-ring.

Warning: The instrument components are liable to be 
contaminated with biologically hazardous and toxic materials. 
Wear rubber gloves at all times while handling the components.
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Plate carrier errors

The sample plate carrier generates primary state information which is 
displayed in the Tune window status bar and reflected in the behavior of the 
plate carrier control buttons. In an error condition the plate carrier generates 
additional secondary information which is displayed in a message box in front 
of the Tune window.

Secondary information is reported as either:

• Position Error

• Plate Carrier ERROR 

In both cases the error must be cleared before normal operation can be 
resumed.

In the Position Error case, the control buttons will change state to 
automatically indicate the correct action to clear the error.

In the Plate Carrier ERROR case, the control buttons are disabled and the 
user must remove and refit the Heater/Interlock cable to clear the error.

Position errors are caused by either the plate carrier not reaching a requested 
position before a internal system time-out or the plate carrier requesting a 
move beyond its limit of travel. This latter case could be caused by an 
inappropriate plate definition.

Plate Carrier ERRORs indicate a system failure. If this state persists after the 
reset sequence contact Waters.
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Support for alternative sample plates

MALDI sample plates not supplied by Waters may be used with the MALDI 
Q-Tof Premier. 

• Where these plates are of the same dimensions as a Standard Waters 
plate only the sample plate definition needs to be modified.

• Where these plates are of a different size to the Standard Waters plate 
the sample plate carrier insert plate must be removed prior to using and 
the sample plate definition modified.

To remove the plate carrier insert:

1. Unload the sample plate

2. Open the plate carrier lid and remove the sample plate if fitted.

3. Using a suitable screwdriver release the captive screw in the center of 
the sample plate carrier insert.

4. Store the carrier insert in the source top cover directly above the plate 
carrier lid.

To revert back to Standard Waters plates the carrier insert must be refitted.

When alternative sample plates of larger dimensions to the Standard Plate 
are used it may not be possible to access all the rows and columns on these 
plates. If a request to move takes the plate carrier beyond the limit of 
movement, a plate carrier error will occur. In this instance refer to Plate 
carrier errors on page 4-4
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Contacting Waters

You can easily correct many problems with the Q-Tof Premier. However, if 
this is not the case, you must contact Waters.

Customers in the USA and Canada should report maintenance problems they 
cannot resolve to Waters Technical Service (800 252-4752). All others should 
visit http://www.waters.com and click Offices, or phone their local Waters 
subsidiary or Waters corporate headquarters at 34 Maple Street, Milford, 
MA 01757, USA.

When contacting Waters, have the following information available:

• The nature of the symptom

• The Q-Tof Premier serial number

Depending on the nature of the fault, it may also be useful to have the 
following information available:

• Details about the flow rate, mobile phases, and sample concentrations

• Tune window settings

• The Software version update reference
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5 Sample Preparation

Sample preparation is accepted as the most important step in mass analysis with 
MALDI mass spectrometers, and the impact of preparation quality on data quality 
cannot be over emphasized. This chapter gives sample and matrix details and 
protocols to act as a guideline. Waters suggests that you keep meticulous records of 
your procedures.
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Safety

Calibration standards

To prepare calibration standards for peptide analysis:

For peptide analysis, calibrate using a polyethylene glycol (PEG) mixture

1. Prepare the following stock solutions:

– 10 mg/mL of PEG 600, 1000, 1500, and 2000 in 1:1 water: 
acetonitrile.

– 2 mg/mL of NaI in 1:1 water: acetonitrile.

2. Mix PEG oligomers: NaI in the ratio 10:10:10:10:6 (v/v).

3. Mix 1:1 with matrix.

4. Spot 1 µL of PEG mix/matrix onto the sample plate and air dry.

Washing stainless steel MALDI plates

To wash plates:

1. Scrub the sample plate in 2% Decon 90 with a soft nylon brush to 
remove matrix deposits. When analyzing synthetic polymers, use a 
suitable organic solvent such as dichloromethane. 

2. Rinse the plate in distilled water.

3. Sonicate for 10 minutes in 1:1:1 dichloromethane: acetone: methanol or 
an alternative degreasing agent. 

4. Sonicate for a further 10 minutes in methanol.

Warning: Many procedures in this chapter involve using 
flammable or caustic agents. There is danger of contamination 
by biological agents that constitute a threat to humans. 
Personnel performing these operations should be aware of the 
risks. Refer to Material Safety Data Sheets and take all 
necessary precautions. 
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5. Dry under a dry nitrogen stream. 

Important: This cleaning procedure does not apply to MassPREP Pro or 
DIOS sample plates. See the relevant User’s Guides.

Sample Preparation Considerations

Consider the following before preparing MALDI samples:

• Expected molecular mass range.

• Concentration or amount of sample supplied.

• Suitable solvent.

• Contaminants present, such as salts, buffers, glycerol. Higher purity 
samples will yield better spectra with less interference.

Tip: You can de-contaminate samples before or after preparing the 
sample spots. For MassPREP Pro sample plates see the relevant User’s 
Guide.

• Sample type. For example, peptide, protein, protein digest, 
oligonucleotide, oligosaccharide, synthetic polymer.

• Sample stability. For example, sensitivity to acid. If the sample is acid 
sensitive then omit TFA from the procedures outlined.

• Molecular structure or principal functional groups.

Matrices

Matrices and Substrates
Matrices and Substrates

Matrix Typical Substrate
CHCA α-cyano-4-hydroxy cinnamic 

acid
Peptides, polymers

Sinapinic 
acid

3,5-dimethoxy-4-hydroxycinna
mic acid

Proteins, peptides, polymers

DHB 2,5-dihydroxybenzoic acid Sugars, peptides, 
nucleotides, polymers
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Matrix Mixtures

Preparing Matrices 
The matrix:sample molar ratio must be > 5000:1. Matrix solutions are light 
sensitive, so prepare fresh each day and keep in a dark tube. A possible 
exception is hydroxypicolinic acid (HPA), which can improve sensitivity for 
oligonucleotides / DNA when the matrix solution has ‘aged’ for up to two 
weeks before analysis, turning brown in color.

CMBT 5-chloro-2-mercaptobenzothiazo
le

Proteins, peptides

Dithranol 1,8-Dihydroxy-9(10H)-anthrace
none

Synthetic polymers

THAP 2,4,6-trihydroxyacetophenone Oligonucleotides

HABA 2-(4-hydroxyphenylazo)benzoic 
acid

Glycolipids, peptides, 
proteins

HPA Hydroxypicolinic acid Oligonucleotides, peptides, 
glycoproteins

IAA β-indole acrylic acid Polymethyl methacylates

3-aminoquinoline Sugars, peptides, 
nucleotides, polymers

4-hydroxy-α-phenylcinnamic 
acid

Proteins, glycoproteins

All trans-retinoic acid Synthetic polymers

Matrix Mixtures and Substrates

Matrix Mixture Substrate
S-DHB = 5-methoxysalicilic acid and 
2,5-dihydroxybenzoic acid (mixed 1:10)

Peptides, proteins

α-cyano-4-hydroxy cinnamic acid and 
2,5-dihydroxybenzoic acid (mixed 3:5)

Synthetic polymers

Anthranilic acid and nicotinic acid Oligonucleotides

Matrices and Substrates

Matrix Typical Substrate
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A washing stage or re-crystallization of the matrix before use can improve 
results, maybe due to a reduced contaminants, such as organic chemicals and 
metal ions. 

Waters has a range of highly purified matrices to cover most application 
areas. These can ordered using the part numbers listed below.

Premix Method

To mix the matrix:

1. Mix 2 µL of sample with 2 µL of matrix solution.

2. Spot 1 µL of this mixture onto the MALDI sample plate.

3. Repeat for the required samples and air dry.

Thin Film Technique

To improve signal strength, but with a reduction in sample longevity, reduce 
the matrix crystal size by seeding the sample spot with a thin film of matrix 
solution (dissolve the matrix in a volatile solvent such as acetone).

Tip: With this matrix preparation it may be beneficial to reduce the laser 
firing rate during the acquisition.

Use a low volume pipette tip such as a Gilson P2 pipette for reproducible 1 µL 
spotting of the volatile matrix solution. Deposit the sample/matrix mixture 
directly onto the thin film and air dry.

CHCA (α-cyano-4-hydroxy Cinnamic Acid)

Use a concentration of 2 to 10 mg/mL in 1:1 aqueous (aq) 0.1% TFA: 
acetonitrile. 

Waters MALDI matrices and part numbers

Matrix Waters Part Number
CHCA 186002331

DHB 186002333

Sinapinic acid 186002332

HPA 186002334

THAP 186002335
Matrices 5-5



For thin film CHCA use a concentration of 10 mg/mL in 495:495:10 ethanol: 
acetonitrile: 0.1% TFA (aq). Dilute this solution 4:1 in 10 mg/mL 
nitrocellulose.

CHCA can also be dissolved in other organic solvents for non-aqueous sample 
preparations, such as synthetic polymers.

For peptide analysis at the low fmol level it is beneficial to use CHCA at a 
concentration of 3.6 mg/mL, as this reduces the level of matrix clusters 
observed. 

Sinapinic Acid (3,5-dimethoxy-4-hydroxycinnamic Acid)

Use a concentration of 10 mg/mL in 4:6 acetonitrile: 0.1% TFA (aq).

To improve the signal, mix sinapinic acid at a ratio of 3:1 matrix to sample.

Thin Film Sinapinic Acid

To obtain improved signal intensities with protein samples use a thin film 
sinapinic acid matrix.

To prepare thin film sinapinic acid matrix:

1. Prepare matrix as above and also at a concentration of 10 mg/mL in 
acetone

2. Apply 1 µL of the thin film solution to the sample plate and air dry. 

3. Mix the sample 1:1 with the standard sinapinic acid matrix preparation 
and apply 1 µL of this mixture over the thin film.

You can also dissolve sinapinic acid in organic solvents to prepare 
non-aqueous samples such as synthetic polymers.

DHB (2,5-dihydroxybenzoic Acid)

Use a concentration of 10 mg/mL in 70:30 water: acetonitrile for general 
peptide analysis or prepare a saturated solution in 20:80 water:acetonitrile for 
the analysis of oligosaccharides.

You can also dissolve DHB in organic solvents to prepare non-aqueous 
samples such as synthetic polymers. Use a concentration of 10 mg/mL in 1:1 
methanol: chloroform.
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S-DHB (‘Super’ DHB)

Add 1 mg of 5-methoxysalicilic acid to 9 mg of DHB, and dissolve the mixture 
in 9:1 0.1% TFA (aq): acetonitrile.

CMBT (5-chloro-2-mercaptobenzothiazole)

Use a concentration of 10 mg/mL in 1:1:1 acetonitrile: methanol: aqueous 0.1% 
Formic acid.

CMBT is not very soluble and must be sonicated before use. This produces a 
saturated solution at the specified concentration.

Dithranol (1,8-Dihydroxy-9(10H)-anthracenone)

Use a concentration of 20 mg/mL in tetrahydrofuran, dichloromethane, 
methanol or hexafluoro-2-propanol (HFIP).

For synthetic polymer analysis use the matrix together with a trifluoroacetic 
acid salt such as sodium, potassium, or silver.

HABA (2-(4-hydroxyphenylazo)-benzoic Acid)

Use a concentration of 3.5 mg/mL in methanol.

Use this matrix for peptide and protein analysis. It is also effective in the 
analysis of glycolipids.

HPA (Hydroxypicolinic Acid)

Use a concentration of 25 mg/mL in 25:75 water: acetonitrile.

Use this matrix together with an ammonium salt solution or an ion exchange 
resin to analyze oligonucleotides.

IAA (β-indole acrylic Acid)

Use a concentration of 10 mg/mL in acetone.

Use this matrix to analyze acrylates.

THAP (2,4,6-trihydroxyacetophenone)

Use a concentration of 25 mg/mL in 1:1 water: acetonitrile.
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Use this matrix together with an ammonium salt solution or an ion exchange 
resin to analyze oligonucleotides.

Anthranilic acid / Nicotinic Acid

Use a concentration of 27.9 mg of anthranilic acid and 12.3 mg of nicotinic acid 
in 500 µL acetonitrile: 300 µL aqueous ammonium citrate (100 mM): 300 µL 
water.

4-hydroxy-α-phenylcinnamic Acid

This matrix is used as an alternative to sinapinic acid. It is particularly useful 
for analyzing glycoproteins as it does not produce matrix adducts. However, 
the overall sensitivity is reduced compared to that of sinapinic acid.

3-aminoquinoline

Use a concentration of 10 mg/mL in 1:1 methanol: 0.1% TFA (aq).

All Trans-retinoic Acid

Use a concentration of 10 mg/mL in THF.

Especially useful for the analysis of high molecular weight polystyrenes.

Analysis of Peptides and Proteins

MALDI can be used to identify proteins from the unique masses of peptide 
fragments produced after specific digestion with protease enzymes. Trypsin is 
typically used to digest proteins that have been isolated electrophoretically 
from biological samples.

In most cases peptides and proteins are water soluble and stable in the 
presence of 0.1% TFA The presence of the acid prevents the analyte becoming 
associated with the walls of the tube. 

Prepare each sample at a concentration of between 10 to 500 fmol/µL 
(peptides) and 1 to 10 pmol/µL (proteins). For unknown sample concentrations 
dilute over 4 orders of magnitude and load 4 separate spots on the sample 
plate. Dilution of the sample often enhances the higher molecular weight 
components, especially in a mixture.
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Use the above concentrations as a starting point. For those samples that do 
not produce signals after trying various matrices, try diluting the sample 
rather than concentrating the sample as a second step.

You can improve the data from salt or buffer contaminated samples by on-spot 
washing. 

Tip: For highly contaminated peptide samples, use a MassPREP Pro sample 
plate to allow rigorous on-spot washing without significant sample loss.

Analyze proteins above 12 kDa with a sinapinic acid matrix, for improved 
sensitivity use the thin film technique. Sinapinic acid produces adducts (M + 
208 Da) that correspond to the addition of sinapinic acid with the loss of 
water. Multiply charged species and multimers are often observed, but the 
[M+H]+ species typically predominates.

Preparing Peptide and Protein Standards
Prepare and store standards at a concentration of 1 mg/mL in 0.1% TFA (aq) 
in a freezer. Dilute to obtain a working concentration of approximately 
10 pmol/µL.

Example standards are shown in the following table.

Dilution Factors for Peptide and Protein Standards

Substance Name
Average 
Molecular 
Mass (Da)

Dilution Factor *

Leucine enkephalin 555.6 180

Bradykinin 1060.2 95

Angiotensin I 1296.5 77

Glu-fibrinogen 1570.6 64

Renin 1759.0 57

ACTH (18-39 clip) 2465.7 40

Insulin (bovine) 5733.5 17

Cytochrome-C (Horse Heart) 12360 8

Myoglobin 16951 6

Trypsinogen 23980 4

Bovine Serum Albumin 66430 1.5
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*Dilution factor of 1 mg/mL solution to give 10 pmol/µL.

Store the above solutions in a freezer and use as required, although solutions 
will deteriorate over time.

Preparing protein digests
Caution: Risk of sample contamination from keratin. Gloves (that have been 
rinsed with water) must be worn throughout the sample handling stages.

In-gel protein digests

To prepare in-gel protein digests:

The following procedure is for manual in-gel digestion of proteins separated by 
2D-polyacryamide gel electrophoresis (Coomassie blue stain).

1. Rinse the gel with distilled water and excise the bands of interest with a 
clean scalpel cutting as close to the protein spot as possible. Chop the 
excised spot into pieces (1 x 1 mm). 

2. If the gel pieces are still blue, rehydrate them in 100 to 150 µL 100 mM 
ammonium bicarbonate and heat to 37 °C. After 10 to 15 min. add an 
equal volume of acetonitrile. 

3. Vortex the solution for 30 seconds, then centrifuge, remove supernatant 
and shrink the gel with acetonitrile. Dry gel fragments in a vacuum 
centrifuge. If the Coomassie stain persists, repeat destaining procedure.

4. Wash the gel fragments with 150 µL water for 5 min. Centrifuge and 
remove supernatant. Add acetonitrile (3 to 4 x volume of gel pieces and 
wait for 10 to 15 min), until gel pieces have shrunk and are white.

5. Dry gel fragments in a vacuum centrifuge.

6. Swell gel fragments in 10 mM DTT 100 mM ammonium bicarbonate 
using minimum volume to completely cover gel then incubate for 30 min 
at 56 °C to reduce protein (this stage is recommended even if the 
proteins were reduced before electrophoresis). Dehydrate gel with 
acetonitrile as above.

7. Centrifuge and remove supernatant then add 55 mM iodoacetamide 
dissolved in 100 mM ammonium bicarbonate using minimum volume to 
completely cover gel, leave for 30 minutes at room temperature in the 
dark.
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8. Centrifuge and remove supernatant, wash with 150 µL 100 mM 
ammonium bicarbonate for 15 min, centrifuge and remove the 
supernatant.

9. Dehydrate gel with acetonitrile.

10. Remove supernatant and dry gel fragments in a vacuum centrifuge.

11. Rehydrate gel particles in a minimum volume of digest buffer 50 mM 
ammonium bicarbonate containing 12.5 ng/µL trypsin (w/v) and 
incubate at 4 °C for 30 to 45 min. After 15 to 20 min add more buffer to 
gel fragments if the gel fragments absorb all the liquid. 

12. Incubate at 37 °C for 16 hr.

13. To recover the peptides add 10 µL of 50% acetonitrile / 5% formic acid to 
the digest mixture and sonicate for 10 minutes. Perform around 2 to 3 
extractions of the digestion mixture with a suitable volume (double the 
volume necessary to immerse gel pieces).

14. Transfer the supernatant after each wash using gel loading pipette tips 
into micro-Eppendorf™ tubes.

Note: The high acid concentration is used to minimize adsorptive sample 
loss.

Tip: ZipTip™ extraction of samples into a lower volume can increase the 
concentration of the recovered peptides. Store the recovered peptides 
below -20 °C.

In-Solution Protein Digests

The first procedure describes a method for the tryptic digestion of 
non-covalently bound proteins using Waters RapiGest™ SF. RapiGest SF is a 
reagent used to enhance in-solution enzymatic digests of proteins by 
solubilizing the proteins, making them more susceptible to enzymatic 
proteolysis without inhibiting enzyme activity, allowing the rapid digestion of 
proteins. 

If the protein has covalent links (disulfide bonds) these will need to be cleaved 
and acetylated.

To digest proteins without disulfide bonds:

1. Prepare 50 mM ammonium bicarbonate solution (39.6 mg ammonium 
bicarbonate in 10 mL H2O). 
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2. Suspend 1 mg of RapiGest in 1 mL of 50 mM ammonium bicarbonate 
(resulting in 0.1% (w/v) RapiGest solution).

3. Dissolve protein in 25 to 50 µL of 0.1% RapiGest solution and vortex.

4. Equilibrate sample at 37 °C for 2 minutes.

5. Add enzyme at a ratio of 1:100 to 1:20 (enzyme: protein, w/w).

6. Incubate the sample at 37 °C for 20 to 60 minutes.

7. If the sample is particularly hydrophobic (for example, membrane 
proteins) boil the protein / RapiGest mixture at 100 °C for 5 minutes, 
cool the sample to room temperature before adding enzyme.

Once the sample is digested the RapiGest should be removed from the 
sample before analysis by MALDI.

8. Prepare stock solution of 500 mM HCl.

9. Add 1:10 (v/v) HCl stock solution: sample (so that pH 2). The final 
concentration of HCl should be 30 to 50 mM.

10. Incubate sample at 37 °C for 30 to 45 minutes. A slight cloudiness is 
normal.

11. The sample can then be directly analyzed by MALDI (or diluted to a 
suitable concentration before analysis). Enhanced results may be 
obtained off a MassPREP Pro sample plate.

To digest proteins with disulfide Bonds:

1. Prepare 50 mM ammonium bicarbonate solution (39.6 mg ammonium 
bicarbonate in 10 mL H2O). 

2. Suspend 1 mg of RapiGest in 500 µL of 50 mM ammonium bicarbonate 
(resulting in 0.2% (w/v) RapiGest solution).

3. Dissolve protein in 25 to 50 µL of 0.2% RapiGest solution and vortex.

4. Add DTT to the protein sample to a final concentration of 5 mM.

5. Heat sample to 60 °C for 30 minutes.

6. Cool sample to room temperature.

7. Add iodoacetamide to the sample to the final concentration of 15 mM, 
place sample in the dark for 30 minutes.

8. Add enzyme at a ratio of 1:100 to 1:20 (enzyme: protein, w/w).
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9. Incubate the sample at 37 °C for 20 to 60 minutes.

10. If the sample is particularly hydrophobic (e.g. membrane proteins) boil 
the protein / RapiGest mixture at 100 °C for 5 minutes, cool sample to 
room temperature before adding enzyme.

Once the sample is digested the RapiGest should be removed from the 
sample before analysis by MALDI.

11. Prepare stock solution of 500 mM HCl.

12. Add 1:10 (v/v) HCl stock solution: sample (so that pH 2). The final 
concentration of HCl should be 30 to 50 mM.

13. Incubate sample at 37 °C for 30 to 45 minutes. A slight cloudiness is 
normal.

Analyze the sample directly by MALDI, or first dilute to a suitable 
concentration. To improve results use a MassPREP Pro sample plate.

Internal LockMass correction from trypsin autolysis peptides
The autolysis fragments of trypsin can be useful for internal LockMass 
correction of a protein digest spectrum. The masses of the observed autolysis 
fragments from porcine and bovine trypsin are shown in the following table. 

Analysis of other compounds

Phosphopeptides
MALDI analysis of phosphopeptides is compromised due to relative 
suppression by non-phosphopeptides, their relative instability (they readily 
lose H3PO4) and non-specific binding to glassware. Your sample preparation 
protocol must be meticulous.

Autolysis Fragment Monoisotopic Masses From Porcine and Bovine Trypsin

Porcine Trypsin Bovine Trypsin
2211.1045 805.4168

2163.0569
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To improve results you can fractionate digests or mixtures to enrich fractions 
containing the phosphopeptide, using either HPLC or stepwise elution from 
ZipTips. To enrich phosphopeptide samples use immobilized metal ion affinity 
chromatography (IMAC).

Phosphopeptides tend to give an improved response with the instrument in 
negative ion mode relative to positive ion mode. Another strategy to identify 
phosphopeptides is differential MALDI mapping, whereby a sample is 
analyzed before and after treatment with a phosphatase enzyme giving mass 
shifts of 80 Da (exact mass 79.9663, HPO3) for a phosphate removal.

Oligonucleotides
Matrix of choice: 25 mg/mL hydroxypicolinic acid in 75:25 acetonitrile: water 
prepared as outlined below. 

Sample: dissolved in deionized water at 1 to10 pmol/µL.

Analyze samples rapidly, do not leave them overnight as the sample / matrix 
will degrade.

Oligonucleotides readily form adducts with cations, leading to reduced 
resolution and sensitivity. It is therefore important to minimize these 
interactions. Improved data quality can be obtained from HPLC / SPE purified 
samples. 

Oligonucleotides are sensitive to enzymes present on the hands, therefore 
wear gloves when handling oligonucleotides. Only use deionized water to 
prepare both the sample and matrix, as other grades, such as HPLC grade 
contain metal ions.

HPA Preparation with Desalting

First desalt the oligonucleotides to remove cations that form adducts and 
result in peak broadening. Desalt the sample is by adding strong cation 
exchange beads, which exchange the metal cation adduct for H+. Use Dowex 
50 W X8 beads, washed thoroughly and stored in deionized water.

Add a small amount of beads to the matrix solution (25 mg/mL 
hydroxypicolinic acid in 75:25 acetonitrile: water) and agitate for at least 4 
hours (or over night). Centrifuge the matrix and remove the supernatant (the 
beads can be discarded). Mix the matrix and sample 1:1 and spot directly onto 
the sample plate.
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Oligonucleotide Calibration

Use oligonucleotides of known masses.

Acquiring Data

Use a higher laser energy setting than for peptides.

Oligosaccharides and Sugars
Matrix of choice: saturated solution DHB in 8:2 acetonitrile: water.

Required sample concentration: usually at pmol/µL concentration.

Sample Preparation

Sugars readily form adducts with metal cations, which can result in a loss of 
resolution and mass accuracy. To reduce these effects, desalt the sample with 
ion exchange beads.

To prepare samples:

1. Mix 2 µL of matrix solution with 2 µL of sugar solution. 

2. Spot 1 to 2 µL of the mixture onto the sample plate and air dry. 

3. Add 0.5 µL of absolute ethanol to recrystallize the sample spot.

Oligosaccharide Calibration

Use sugars of known masses.

Acquiring Data

Use a higher laser energy setting than for peptides.

Glycoproteins
To resolve the glycoforms the sample must be rigorously desalted, as cations 
will adduct with the carbohydrate side-chains resulting in peak broadening. 
The ion exchange desalting procedure detailed for oligonucleotides can be 
applied to glycoproteins using 4-hydroxy-α-phenylcinnamic acid as the matrix.
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Glycolipids
Matrix: HABA, 3.5 mg/mL in methanol.

Sample: 1 to 100 pmol/µL in methanol.

Sample Preparation

The premix method of sample preparation is suitable for glycolipids. 

To prepare samples:

1. Mix 2 µL of the matrix solution with 2 µL of the sample solution. 

2. Spot 1 µL of this mixture onto the sample well and air dry.

Glycolipids Calibration

Peptide mixtures are suitable for calibrating the instrument for glycolipid 
sample analysis.

Small Molecules / Pharmaceutical Products
Pharmaceutical products are best analyzed with a DIOS sample plate, 
although standard plates may also be used. See DIOS User’s Guide for sample 
preparation / calibration guidelines.

Analysis of Synthetic Polymers
MALDI can provide useful information on synthetic polymers, such as repeat 
unit mass and end group mass(es). It is also possible to determine Mw and Mn 
values for monodisperse polymers that are in good agreement with other 
techniques such as GPC (gel permeation chromatography), viscometry and 
light scattering. 

It is well documented, however, that Mw and Mn values determined by MALDI 
for polydisperse polymers, tend not to agree with values obtained using 
traditional methods. MALDI analysis tends to yield a polydispersity of 
approximately 1 and Mw and Mn skewed towards the low-mass end of the 
polymer distribution. 

Several physical factors give rise to this effect, including more facile 
desorption / ionization of low-mass oligomers, ‘dimerization’ or multiple 
charging of long-chain polymers. The most common approach to overcoming 
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this fundamental limitation of MALDI is fractionation using GPC before 
analysis.

Matrices

Virtually all the common matrices used for MALDI have been used to analyze 
synthetic polymers. A general starting point is to dissolve the matrix and 
sample in the same solvent, using as volatile a solvent as possible. Matrices 
are typically employed at a concentration of 10 to 20 mg/mL.

Many synthetic polymers show good results by using methods containing the 
reagents 20 mg/mL dithranol in THF and either 1 mg/mL lithium, sodium, 
potassium or silver trifluoroacetate in THF.

To prepare samples:

1. Prepare a sample concentration of 10 mg/mL in THF. 

2. Mix 10 µL of sample and 10 µL of matrix.

3. Add 1 µL of salt (i.e. Na+, K+ or Ag+).

4. Spot 1µL of this mixture onto the sample plate. 

Tip: If there is no signal, vary the ratio of sample: matrix: salt. Diluting 
the sample may improve signal quality.

Common Solvents Suitable for Dissolving Synthetic Polymers and Matrices

Matrix Solvents
CHCA Acetone, MeOH, THF

Sinapinic acid Acetone, methanol, THF

DHB Acetonitrile, methanol, H2O

β-indole acrylic acid Acetone

HABA THF

All trans-retinoic 
acid

THF

Dithranol THF, CHCl3, HFIP
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When running acrylates in β-indole acrylic acid the solvent of choice should be 
acetone. When applying the mixture of sample and matrix to the sample well, 
drag the pipette tip across the surface during the drying process whilst 
applying more sample / matrix solution, until about 2µL has been deposited.

Polymer Classification and Suitable Matrices

Polymer Suitable Matrix
Acrylates β-indole acrylic acid, Dithranol

Unsaturated 
aromatic polyesters

Dithranol + silver trifluoroacetate

High molecular 
weight polystyrene

Retinoic acid + saturated ethnical silver nitrate

Resins Dithranol

PEG CHCA in acetone + sodium iodide
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Structures of MALDI Matrices

Structure and [M+H]+ of Common MALDI Matrices

Structure Name [M+H]+

CMBT 
(5-chloro-2-mercapto
benzothiazole)

Average: 
216.7322
Mono: 
215.9708

Sinapinic acid
(3,5-dimethoxy-4-
hydroxycinnamic acid)

Average: 
225.2212
Mono: 
225.0763

CHCA
(α-cyano-4-hydroxy
cinnamic acid)

Average: 
190.1784
Mono: 
190.0504

4-hydroxy-α-phenyl 
cinnamic acid

Average: 
241.2619
Mono: 
241.0865

DHB
(2,5-dihydroxybenzoic 
acid)

Average: 
155.1301
Mono: 
155.0344

S

NH2

Cl

SH

O

OH

O
OH

OCH3

CH3

N

OH

O

OH

OH

OH

O

OH

O

OH

OH
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THAP
(2’,4’,6’-trihydroxy
benzoic acid)

Average: 
169.1570
Mono: 
169.0501

HPA, 
Hydroxypicolinic acid
(3-Hydroxy-2-pyridinec
arboxylic acid)

Average: 
140.1185
Mono: 
140.0347

IAA
(β-indole acrylic acid)

Average: 
188.2059
Mono: 
188.0711

HABA
(2,-(4-hydroxyphenyl-
azo)-benzoic acid)

Average: 
243.2420
Mono: 
243.0769

All trans-retinoic acid Average: 
301.4431
Mono: 
301.2168

Structure and [M+H]+ of Common MALDI Matrices

Structure Name [M+H]+

O

OH

OH

CH3

OH

N

O

OH

OH

NH

OH

O

N N

O

OH

OH

CH3 CH3

CH3

CH3CH3

O

OH
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Dithranol
(1,8-Dihydroxy-9(10H)-
anthracenone)

Average: 
227.2395
Mono: 
227.0708

Structure and [M+H]+ of Common MALDI Matrices

Structure Name [M+H]+

O OHOH
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